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 Avaya Solution & Interoperability Test Lab 
 

Application Notes for Configuring SIP Trunking using Bell 

Canada SIP Trunk Services with Avaya IP Office Release 

11.1 – Issue 1.0 
 

Abstract 
 

  

These Application Notes describe a reference configuration using Session Initiation Protocol 

(SIP) trunking between the Bell Canada SIP Trunk Services offer and an Avaya IP Office 

solution. In the reference configuration, the Avaya IP Office solution consists of an Avaya IP 

Office Server Edition Primary Server Release 11.1, an Avaya IP500 V2 Expansion System 

Release 11.1, Voicemail Pro and Avaya SIP, H.323, digital, and analog endpoints. 

 

The Bell Canada SIP Trunk Services offer referenced within these Application Notes is 

designed for business customers. The service enables local and long distance PSTN calling via 

standards-based SIP trunks directly, without the need for additional TDM enterprise gateways 

or TDM cards and the associated maintenance costs. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases 

are adequately covered by this scope and results. 

 

Information in these Application Notes has been obtained through DevConnect compliance 

testing and additional technical discussions. Testing was conducted in the Avaya Solution & 

Interoperability Test Lab. 
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1. Introduction 
These Application Notes describe a reference configuration using Session Initiation Protocol 

(SIP) trunking between the Bell Canada SIP Trunk Services and an Avaya IP Office solution. In 

the reference configuration, the Avaya IP Office solution consists of an Avaya IP Office Server 

Edition Primary Server, an IP500 V2 Expansion System, Voicemail Pro and Avaya SIP, H.323, 

digital, and analog endpoints.  

 

Avaya IP Office is a versatile communications solution that combines the reliability and ease of 

a traditional telephony system with the applications and advantages of an IP telephony solution. 

This converged communications solution can help businesses reduce costs, increase productivity, 

and improve customer service. 

 

Customers using this Avaya SIP-enabled enterprise solution with Bell Canada SIP Trunk 

Services are able to place and receive PSTN calls via a broadband WAN connection and the SIP 

protocol. This converged network solution is an alternative to traditional PSTN trunks such as 

ISDN-PRI 

2. General Test Approach and Test Results  
The general test approach was to connect a simulated enterprise site to the Bell Canada SIP 

Trunk Services, as depicted in Figure 1. Avaya IP Office was configured to use the 

commercially available SIP Trunking solution provided by the Bell Canada SIP Trunk Services. 

This allowed Avaya IP Office users to make calls to the PSTN and receive calls from the PSTN 

via the Bell Canada SIP Trunk Services. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent 

to the interoperability of the tested products and their functionalities. DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in these DevConnect 

Application Notes included the enablement of supported encryption capabilities in the Avaya 

products. Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

 

Support for these security and encryption capabilities in any non-Avaya solution component is 

the responsibility of each individual vendor. Readers should consult the appropriate vendor-

supplied product documentation for more information regarding those products. 

2.1. Interoperability Compliance Testing 

To verify SIP trunking interoperability, the following features and functionality were covered 

during the interoperability compliance test: 
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• Incoming calls from the PSTN were routed to the DID numbers assigned by Bell Canada 

to the Avaya IP Office location. These incoming PSTN calls arrived via the SIP Line and 

were answered by Avaya SIP telephones, Avaya H.323 telephones, Avaya digital 

telephones, analog telephones, analog fax machines, Avaya IX Workplace for Windows 

softphones and Avaya Voicemail Pro. The display of caller ID on display-equipped 

Avaya IP Office telephones was verified. 

• Incoming calls answered by members of Hunt Groups were verified. 

• Outgoing calls from the Avaya IP Office location to the PSTN were routed via the SIP 

Line to Bell Canada. These outgoing PSTN calls were originated from Avaya SIP 

telephones, Avaya H.323 telephones, Avaya digital telephones, analog endpoints, Avaya 

IX Workplace for Windows and Avaya Voicemail Pro. The display of caller ID on 

display-equipped PSTN telephones was verified. 

• Inbound / Outbound fax using G.711 and T.38 were verified. 

• Proper disconnect when the caller abandoned a call before answer for both inbound and 

outbound calls. 

• Proper disconnect when the IP Office party or the PSTN party terminated an active call. 

• Proper busy tone heard when an IP Office user called a busy PSTN user, or a PSTN user 

called a busy IP Office user (i.e., if no redirection was configured for user busy 

conditions). 

• Various outbound PSTN call types were tested including long distance, international, 

toll-free, operator assisted, and directory assistance calls. 

• Requests for privacy (i.e., caller anonymity) for IP Office outbound calls to the PSTN 

were verified. That is, when privacy is requested by IP Office, outbound PSTN calls were 

successfully completed while withholding the caller ID from the displays of display-

equipped PSTN telephones.  

• Privacy requests for inbound calls from the PSTN to IP Office users were verified. That 

is, when privacy is requested by a PSTN caller, the inbound PSTN call was successfully 

completed to an IP Office user while presenting an “anonymous” display to the IP Office 

user. 

• SIP OPTIONS monitoring of the health of the SIP trunk was verified. Both Bell Canada 

and IP Office were able to monitor SIP trunk health using SIP OPTIONS. 

• IP Office outbound calls were placed with simple short codes as well as using ARS. 

Using ARS, the ability of IP Office to route-advance to an alternate route was exercised 

when the primary SIP line was not responding. The Line Group associated with the Bell 

Canada SIP Trunk was the primary line group chosen for a call, or an alternate line group 

was selected upon failure of a primary line. 

• Incoming and outgoing calls using the G.729A and G.711MU codecs. 

• DTMF transmission (RFC 2833) with successful voice mail navigation using G.729 and 

G.711MU for incoming and outgoing calls.. 

• Inbound and outbound long holding time call stability. 

• Telephony features such as call waiting, hold, transfer, and conference. 

• Unattended and attended call transfer using the SIP INVITE method. 

• Calling Name and Number Presentation: Dynamic Outgoing Name and Number Display 

(Dynamic ONND) and Static Outgoing Name and Number Display (Static ONND).  
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• Mobile twinning to a mobile phone, presenting true calling party information to the 

mobile phone. Mobility Features such as Outbound and Inbound Mobile Call Control.  

were also verified successfully. 

• DiffServ markings in accordance with network requirements for IP Office SIP signaling 

and RTP media. 

2.2. Test Results 

Interoperability testing of the reference configuration was completed with successful results. The 

following observations were noted: 

  

• Emergency 911/E911 Services Limitations and Restrictions – Although Bell Canada 

provides 911/E911 calling capabilities, 911 capabilities were not tested; therefore, it is 

the customer’s responsibility to ensure proper operation with its equipment/software 

vendor. 

 

Note – These Application Notes describe the provisioning used for the sample configuration 

shown in Figure 1. Other configurations may require modifications to the provisioning described 

in this document. 

2.3. Support 

For technical support on the Avaya products described in these Application Notes visit 

http://support.avaya.com. 

 

For more detail about Bell Canada SIP Trunk Services offer, follow the online support links at 

https://business.bell.ca/shop/medium-large/voice-unified-communications/voice-solutions 

 

 

  

http://support.avaya.com/
https://business.bell.ca/shop/medium-large/voice-unified-communications/voice-solutions
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3. Reference Configuration 
Figure 1 illustrates an example Avaya IP Office solution connected to the Bell Canada SIP 

Trunk Services. The Avaya equipment is located on a private IP subnet. An enterprise edge 

router provides access to the Bell Canada SIP Trunk Services network via a Bell Canada. 

 

The reference configuration consisted of the following components: 

• Avaya IP Office provides the voice communications services for a particular enterprise site. 

In the reference configuration, Avaya IP Office runs on the Avaya IP Office Server Edition 

platform. Note that this solution is extensible to deployments using the standalone IP500 V2 

platform as well.  

• In the sample configuration, the Primary server runs the Avaya IP Office Server Edition 

Linux software. Avaya Voicemail Pro, running as a service on the Primary Server, provided 

the voice messaging capabilities in the reference configuration.  

• The Expansion System (V2) is used for the support of digital, analog and additional IP 

stations. It consists of an Avaya IP Office 500 V2 with analog and digital extension 

expansion modules, as well as a VCM64 (Voice Compression Module). 

• Avaya endpoints are represented with Avaya 9608 H.323 Deskphones, Avaya J169 SIP 

Deskphones, Avaya 1140E SIP Deskphones, Avaya 9508 Digital Deskphones, as well as 

Avaya IX Workplace for Windows (SIP) softphones. Fax endpoints are represented by PCs 

running Ventafax emulation software connected by modem to the IP Office analog ports. 

• In the reference configuration, Avaya IP Office interface “LAN 1” (labeled LAN) is 

connected to the private CPE, and interface “LAN 2” (labeled WAN) is connected to the 

public network and Bell Canada SIP Trunk Services.  

• In the reference configuration, Avaya IP Office receives traffic from the Bell Canada SIP 

Trunk Services on port 5060 and sends traffic to port 5060, using UDP for network transport, 

as required by the Bell Canada SIP Trunk Services.  

• Bell Canada SIP Trunk Services provided Direct Inward Dial (DID) numbers. These DID 

numbers were mapped to IP Office destinations via Incoming Call Routes in the IP Office 

configuration. 
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Figure 1: Avaya Interoperability Test Lab Configuration 
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4. Equipment and Software Validated 
Table 2 shows the equipment and software used in the reference configuration. 

 

Avaya IP Telephony Solution Components 

Equipment Software 

Avaya IP Office Server Edition 

- Avaya IP Office Voicemail Pro 

Release 11.1.0.0.0 Build 237 

Release 11.1.0.0.0 Build 234 

Avaya IP Office 500 V2 Expansion System Release 11.1.0.0.0 Build 237 

Avaya IP Office Manager Release 11.1.0.0.0 Build 237 

Avaya 96x1 Series IP Deskphone (H.323) Release 6.8304 

Avaya 1140E IP Deskphone (SIP) Release 04.04.23.00 

Avaya J169 IP Deskphone (SIP) Release 4.0.4.0.10 

Avaya IX Workplace Client for Windows Release 3.8.4.10.2 

Avaya 9508 Digital Deskphone Release 0.60 

Bell Canada 

Acme Packet Net-Net SBC SCZ7.4.0 MR-2 GA (Build 446) 

Broadsoft SoftSwitch R22 

 

Table 1: Equipment and Software Tested 

 

Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. Note 

that IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital 

endpoints or trunks. 
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5. Avaya IP Office Primary Server Configuration 
IP Office is configured via the IP Office Manager program. For more information on IP Office 

Manager, consult reference [4]. From the IP Office Manager PC, select Start → Programs → 

IP Office → Manager to launch the Manager application. Navigate to File → Open 

Configuration (not shown), select the proper Avaya IP Office system from the pop-up window, 

and log in using the appropriate credentials. 

 

 
 

On Server Edition systems, the Solution View screen will appear, similar to the one shown 

below. All the Avaya IP Office configurable components are shown in the left pane, known as 

the Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., 

IPOSE110, on the navigation pane will expand the menu on this server. In the sample 

configuration, IP users registered to the Primary server. Digital and Analog users are configured 

on the Expansion System. The SIP trunk to Bell Canada is configured on the Primary server. 
 



 
KP; Reviewed: 

SPOC 11/17/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

9 of 47 

Bell-IPO11 

 

 
 

In the screens presented in the following sections, the View menu was configured to show the 

Navigation pane on the left side, the Group pane in the center and the Details pane on the right 

side. These panes will be referenced throughout the rest of this document.  

 

Standard feature configurations that are not directly related to the interfacing with the service 

provider are assumed to be already in place, and they are not part of these Application Notes. 
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5.1. Licensing  

In the reference configuration, IPOSE110 was used as the system name of the Primary Server 

and EXP110 was used as the system name of the Expansion System. All navigation described in 

the following sections (e.g., License) appears as submenus underneath the system name in the 

Navigation Pane. 

 

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative.  
 

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status 

for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the 

number of channels provisioned for the SIP trunk. 
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5.2. System Settings 

This section illustrates the configuration of system settings. Select System in the Navigation 

pane to configure these settings. The subsection order corresponds to a left to right navigation of 

the tabs in the Details pane for System settings. For all the following configuration sections, the 

OK button (not shown) must be selected in order for any changes to be saved. 

5.2.1. LAN1 Settings 

In the reference configuration, LAN1 is used to connect the Primary server to the enterprise 

network. To view or configure the IP Address of LAN1, select the LAN1 tab followed by the 

LAN Settings tab. As shown in Figure 1, the IP Address of the Primary server is 10.33.1.110. 

Other parameters on this screen may be set according to customer requirements. 
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Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable parameter 

is checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya 

96x1 deskphones used in the reference configuration. The H.323 Signaling over TLS is set to 

Preferred to allow TLS signaling for H.323 endpoint that support it. The SIP Registrar Enable 

parameter is checked to allow Avaya J169, Avaya 1140E, and Avaya IX Workplace usage. The 

SIP Domain Name and SIP Registrar FQDN may be set according to customer requirements. 

Set the parameters on the Layer 4 Protocol section based on customer needs.  
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5.2.2. LAN2 Settings 

In the sample configuration, LAN2 is used to connect the IP Office to the Bell Canada network. 

To view or configure the IP Address of LAN2, select the LAN2 tab followed by the LAN 

Settings tab. As shown in Figure 1, the IP address of the IP Office, known to Bell Canada, is 

“192.168.80.110”. DHCP Mode is set to “Disabled” since DHCP is unnecessary in this setup.  
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Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable and SIP 

Registrar Enable boxes are unchecked since IP telephones will not be registering on this link. 

The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to Bell 

Canada. 

 

If desired, the RTP Port Number Range can be customized to a specific range of receive ports 

for the RTP media paths from Bell Canada to IP Office. The defaults are used here. 
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Scrolling down the page, on the Keepalives section, set the Scope to RTP-RTCP. Set the 

Periodic timeout to 30 and the Initial keepalives parameter to Enabled. These settings will 

cause the Primary server to send RTP and RTCP keepalive packets starting at the time of initial 

connection and every 30 seconds thereafter if no other RTP or RTCP traffic is present. This 

facilitates the flow of media in cases where each end of the connection is waiting to see media 

from the other, as well as helping to keep ports open for the duration of the call. 

 

In the DiffServ Settings section, the Primary server can be configured to mark the Differentiated 

Services Code Point (DSCP) in the IP Header with specific values to support Quality of Services 

(QoS) policies for both signaling and media. The DSCP field is the value used for media, while 

the SIG DSCP is the value used for signaling. These settings should be set according to the 

customer’s QoS policies in place. In the sample configuration shown below, IP Office will mark 

the RTP media with a value associated with “Expedited Forwarding” using DSCP decimal 46 

(DSCP parameter). IP Office will mark SIP signaling with a value associated with “Assured 

Forwarding” using DSCP decimal 34 (SIG DSCP parameter). 
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Select the Network Topology tab as shown in the following screen. The Firewall/NAT Type 

was set to Open Internet in the sample configuration. Note that the Firewall/NAT Type 

parameter may need to be set differently, depending on the type of firewall or Network Address 

Translation device used at the customer premise. Binding Refresh Time (sec) was set to 60 

seconds. This is used to determine the frequency at which Avaya IP Office will send SIP 

OPTIONS messages, to periodically check the status of the SIP trunk connection to Bell Canada. 

The Public IP Address and Public Port sections are not used for the Bell Canada SIP trunk 

service connection. 

 

 

5.2.3. Voicemail Settings 

To view or change voicemail settings, select the Voicemail tab as shown in the following screen.  

The settings presented here simply illustrate the reference configuration and are not intended to 

be prescriptive. The Voicemail Type in the reference configuration is Voicemail Lite/Pro. The 

Voicemail IP Address in the reference configuration is 10.33.1.110, the IP address of the 

Primary server running the Voicemail Pro software.  
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5.2.4. System Telephony Settings 

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as 

shown in the following screen. The settings presented here simply illustrate the reference 

configuration and are not intended to be prescriptive. In the reference configuration, the Inhibit 

Off-Switch Forward/Transfer parameter is unchecked so that call forwarding and call transfer 

to PSTN destinations via the Bell Canada SIP Trunk Services can be tested. That is, a call can 

arrive to IP Office via the Bell Canada SIP Trunk, and be forwarded or transferred back to the 

PSTN with the outbound leg of the call using the Bell Canada SIP Trunk service. The 

Companding Law parameters are set to U-Law as is typical in North American locales. Other 

parameters on this screen may be set according to customer requirements. 
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5.2.5. System VoIP Settings  

To view or change system codec settings, select the VoIP → VoIP tab. The RFC2833 Default 

Payload field allows for the manual configuration of the payload type used on SIP calls that are 

initiated by the IP Office. During the compliance test, this was set to 101, the value preferred by 

Bell Canada. For codec selection, on the left, observe the list of Available Codecs. In the 

example screen below, which is not intended to be prescriptive, the parameter next to each codec 

is checked, making all the codecs available in other screens where codec configuration may be 

performed (such as the SIP Line in Section 5.4.5). The Default Codec Selection area enables the 

codec preference order to be configured on a system-wide basis, using the up, down, left, and 

right arrows. By default, all IP (SIP and H.323) lines and extensions will assume the system 

default codec selection, unless configured otherwise for the specific line or extension.  
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During the compliance test, SRTP was used internal to the enterprise wherever possible. To view 

or configure the media encryption settings, select the VoIP → VoIP Security tab on the Details 

pane. The Media Security drop-down menu is set to Preferred to have IP Office attempt use 

encrypted RTP for devices that support it and fall back to RTP for devices that do not support 

encryption. Under Media Security Options, RTP is selected for the Encryptions and 

Authentication fields. Under Crypto Suites, SRTP_AES_CM_128_SHA1_80 is selected. 

 

 

5.3. IP Route 

In the reference configuration, the Primary server LAN1 port is physically connected to the local 

area network switch at the IP Office customer site. The default gateway for this network is 

10.33.1.1.  

 

The IP Office LAN2 port is physically connected to the public network and has a default 

gateway of 192.168.80.1. To add an IP Route in the Primary server, right-click IP Route from 

the Navigation pane, and select New (not shown). To view or edit an existing route, select IP 

Route from the Navigation pane, and select the appropriate route from the Group pane. The 

following screen shows the Details pane with the relevant route using LAN2 as Destination. 
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5.4. SIP Line 

This section shows the configuration screens for the SIP Line in IP Office Release 11.1. The 

recommended method for configuring a SIP Line is to use the template associated with these 

Application Notes. The template is an .xml file that can be used by IP Office Manager to create a 

SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses 

• SIP Credentials (if applicable) 

• SIP URI entries 

• Setting of the Use Network Topology Info field on the Transport tab. 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary 

after the SIP Line is created via the template. The resulting SIP Line data can be verified against 

the manual configuration shown in Sections 5.4.2 – 5.4.7. 

 

In addition, the following SIP Line settings are not supported on Basic Edition: 

 

• SIP Line – Originator number for forwarded and twinning calls. 

• Transport – Second Explicit DNS Server. 

• SIP Credentials – Registration Requirement. 

• SIP Advanced Engineering. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation 

Pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.4.2 – 5.4.7.  
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5.4.1. Creating a SIP Line from an XMLTemplate 

Note – DevConnect generated SIP Line templates are always exported in an XML format. 

These XML templates do not include sensitive customer specific information and are 

therefore suitable for distribution. The XML format templates can be used to create SIP 

trunks on both IP Office Standard Edition (500v2) and IP Office Server Edition systems. 

Alternatively, binary templates may be generated. However, binary templates include all the 

configuration parameters of the Trunk, including sensitive customer specific information. 

Therefore, binary templates should only be used for cloning trunks within a specific 

customer’s environment. 

 

Copy a previously created template file to the computer where IP Office Manager is installed. To 

create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate 

to New →New from Template. Select Open from file.  

 

 
 

Navigate to the directory where the template was copied on the local computer (e.g., Desktop) 

and select it. Click Open (not shown). 
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The new SIP Line is created, and it will appear on the Navigation pane (e.g., SIP Line 8). The 

resulting SIP Line data can be verified against the manual configuration shown in Sections 5.4.2 

to 5.4.7. 

 

 

5.4.2. SIP Line – SIP Line Tab 

Bell Canada SIP Trunk Services supports two types of calling display for customer: Static 

ONND and Dynamic ONND therefore the different calling display will have different setting of 

SIP Line.  

 

Static ONND: SIP Line tab 

• ITSP Domain Name: set to the Bell SIP domain, e.g. “ISTPdomian.bell.ca”. 

• Local Domain Name: set to the customer SIP domain assigned from Bell, e.g. 

“customerdomain.ca”. 

• In Service and Check OOS fields are checked by default. 

• Refresh Method: set to “Auto”. 

• Timer (sec): set to “On Demand”. 

• Incoming Supervised REFER and Outgoing Supervised REFER: set to “Auto”. 

• Outgoing Blind REFER: checked to enable. 
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Dynamic ONND: SIP Line tab. 

 

• ITSP Domain Name: set to the SIP domain, e.g. “customerdomain.ca”. Note that this 

domain is assigned to the customer from Bell. 

• Local Domain Name: leave it blank. 

• In Service and Check OOS fields are checked by default. 

• Refresh Method: set to “Auto”. 

• Timer (sec): set to “On Demand”. 

• Incoming Supervised REFER and Outgoing Supervised REFER: set to “Auto”. 

• Outgoing Blind REFER: checked to enable. 
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5.4.3. SIP Line - Transport 

Both Static ONND and Dynamic ONND have the same setting for the Transport tab as shown 

below. The ITSP Proxy Address is set to the IP address provided by Bell Canada 

192.168.237.208, as shown in Figure 1. In the Network Configuration area, UDP is selected as 

the Layer 4 Protocol. The Send Port is set to the port number provided by Bell Canada which is 

5060. The Listen Port can retain the default value 5060. The Use Network Topology Info 

parameter is set to None. 

 

 
 

5.4.4. SIP Line – Call Details Tab 

Static ONND: Select the Call Details tab. The Incoming Group and Outgoing Group fields 

are set to the number of SIP Line it is the line 8 in this case. The Credentials is selected as the 

credentials configured in the SIP Credentials tab in Section 5.4.6.  The Local URI, Contact, P 

Asserted ID and Diversion Header fields are configured as shown in the picture. 
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Dynamic ONND: the dynamic ONND setting will have two lines of URI. One is used for 

incoming calls and another is used for outgoing calls. The screen below shows the SIP URI for 

the incoming calls. The Incoming Group is set to the SIP Line number 8 while the Outgoing 

Group field is set to an unassigned SIP Line number, in this case the number 100 is used. Select 

the credentials that will be configured in the next step in the Credentials field. 

 

 
 

The second URI is used for the dynamic ONND outgoing calls. The Incoming Group field is set 

to an unassigned Line number, e.g. Line 100 in this case and the Outgoing Group field is set to 

the Line number 8. Select the credentials from the list in the Credentials field.  

 

The important field in this URI is the Contact header. The Content filed must have the pilot 

DID number and trunk group id information as shown below 

“613xxxx771;tgrp=VEND10_613xxxx771_01A;trunk-context=ITSPdomain.bell.ca”. Other 

fields are configured as shown in the screenshot below. 
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5.4.5. SIP Line - VoIP Tab 

Select the VoIP tab. The Codec Selection drop-down parameter System Default (default) will 

match the codecs set in the system wide Default Selection list (System → VoIP). In the 

reference configuration, Custom is selected and the codecs  G.711 ULAW 64K and G729(a) 

8K CS-ACELP preferred by Bell Canada are specified. This will cause IP Office to include 

these codecs in the Session Description Protocol (SDP) offer, in that order. The Fax Transport 

Support drop-down is set to T38 Fallback. This enables T.38 to be used for fax if supported, 

and will fall back to G.711 if not. The DTMF Support parameter can remain set to the default 

value RFC2833/RFC4733. The Media Security parameter can retain its default value of 

“Disabled” as Bell Canada does not support media encryption. The Re-invite Supported 

parameter is checked to allow for codec re-negotiation in cases where the target of an incoming 

call or transfer does not support the codec originally negotiated on the trunk. The 

PRACK/100rel Supported is checked as supported by Bell Canada. 

 

Static ONND and Dynamic ONND use the same configuration in the VOIP tab. 
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5.4.6. SIP Line – SIP Credentials 

Select SIP Credentials. Select Add button (not shown) to add a new SIP Credentials. Enter user 

name in the User name field and password in the Password and Confirm Password fields. The 

user name and password of the SIP credentials are provided by Bell Canada. 

 

Static ONND and Dynamic ONND use the same configuration in the SIP Credentials tab. 
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5.4.7. SIP Line – SIP Advanced Tab 

Select the SIP Advanced tab. In the Identity area, the Add user=phone parameter is checked 

this requires for Static ONND, this parameter is not checked for dynamic ONND. For the other 

parameters use the same configuration for both static ONND and dynamic ONND.  

 

The Use Domain for PAI parameter is checked to include the sip domain in the P-Asserted-

Identity (PAI) SIP header. In the Media area, the Indicate HOLD parameter is checked to have 

IP Office send an INVITE with media attribute “sendonly”, indicating the call was placed on 

hold. This is the preferred behavior for Bell Canada to indicate placing a call on hold. 

 

In the Call Control area, the Emulate NOTIFY for REFER parameter is checked. This is 

required for some SIP endpoints that perform Refer based transfers across the SIP line. The No 

REFER if using Diversion parameter is checked to prevent IP Office from using the SIP 

REFER method on call forwarded scenarios that use a Diversion SIP header. 

 

This screenshot below shows the SIP Advanced tab for static ONND with the Add user=phone 

parameter is checked. 
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This screenshot below shows the SIP Advanced tab for dynamic ONND with the Add 

user=phone parameter is unchecked. Keep the other parameters as the same as the static ONND. 
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5.5. IP Office Line 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the IP500 V2 Expansion 

System. 

 

 
 

The screen below shows the IP Office Line, VoIP Settings tab. In the reference configuration, a 

fax machine is connected to one of the analog ports on the Expansion System. Fax Transport 

Support is set to T.38 Fallback. The Media Security is set to Same as System (Preferred) to 

have IP Office use the system setting for media security set in Section 5.2.5 to encrypted RTP. 

Default values were used for all other parameters. 
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5.6.  Short Codes 

In this section, various examples of IP Office short codes will be illustrated. To add a short code, 

right click on Short Code in the Navigation pane, and select New. To edit an existing short code, 

click Short Code in the Navigation pane, and the short code to be configured in the Group pane. 

 

In the screen shown below, the short code 9N is illustrated. The Code parameter is set to 9N. 

The Feature parameter is set to Dial. The Telephone Number parameter is set to N. The 

Telephone Number field is used to construct the Request URI and To Header in the outgoing 

SIP INVITE message. The Line Group ID parameter is set to 52: Bell Canada, which directs 

the call to the ARS. See Section 5.9 for example ARS route configuration.  

 

 

5.7. Users and Extensions 

In this section, examples of an IP Office User and Extension will be illustrated. In the interests of 

brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration 

can be easily extrapolated to other users. To add a User, right click on User in the Navigation 

pane, and select New. To edit an existing User, select User in the Navigation pane, and select the 

appropriate user to be configured in the Group pane. 
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5.7.1. SIP User 

The following screen shows the User tab for user 4303. As shown in Figure 1, this user 

corresponds to the Avaya 1140 SIP endpoint. 

 

 
 

In the SIP tab, enter the assigned DID number from Bell Canada to the SIP Name and SIP 

Display Name fields. The DID will be inserted in the host part of the From header for outgoing 

call as well as used for incoming call with the incoming call route. Note that the four “xxxx” is 

placed in the middle of the DID to omit the real DID, the full and actual DID should be used in 

the customer system. 
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5.7.2. SIP Extension 

The following screen shows the Extension information for this user. To view, select Extension 

from the Navigation pane, and the appropriate extension from the Group pane. 

 

 
 

The following screen shows the VoIP tab for the extension. The IP Address field may be left 

blank. Check the Reserve Avaya IP endpoint license box. The Codec Selection parameter may 

retain the default setting “System Default” to follow the system configuration shown in Section 

5.2.5. The Media Security parameter may also retain the default setting Same as System 

(Preferred) to follow the system configuring shown in Section 5.2.5. 
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5.8. Incoming Call Routes 

In this section, IP Office Incoming Call Routes are illustrated. To add an incoming call route, 

right click on Incoming Call Route in the Navigation pane and select New. To edit an existing 

incoming call route, select Incoming Call Route in the Navigation pane, and the appropriate 

incoming call route to be configured in the Group pane. 

 

In the screen shown below, a simple incoming call route is illustrated. The Line Group Id is 8, 

matching the Incoming Group field configured in the SIP URI of the Call Details tab for the 

SIP Line to Bell Canada, in Section 5.4.4. The Incoming Number field is set to the incoming 

number on which this route should match. Matching is right to left. 

 

Note: When the destination is a user’s extension, the Incoming Number can be used to 

construct the From and Contact headers in place of the extension number in the outgoing SIP 

INVITE message for the user, for caller ID purposes. 

 

 
 

On the Destinations tab, select the destination extension from the pull-down menu of the 

Destination field. Click the OK button (not shown). In this example, incoming calls to  

613xxxx771 on line 8 are routed to extension 4300. Note that the 4 “x” are placed in the middle 

of DID number to omit the real DID number. 
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5.9. ARS Routing 

While detailed coverage of ARS is beyond the scope of these Application Notes, this section  

includes some basic screen illustrations of the ARS settings used during the compliance test. 

 

As described in Section 5.6, Short Code 9N was defined for ARS access. Therefore, outbound 

calls via ARS are dialed as 9 plus the number. ARS will strip off the 9, and it will process the 

call based on the remaining digits.  

 

To add a new ARS route, right-click ARS in the Navigation pane, and select New (not shown).  

The following screen shows the ARS Route ID 52, created in the sample configuration. The 

sequence of Xs used in the Code column of the entries are used to specify the exact number of 

digits to be expected following the access code. The first entry below shows that for calls to area 

codes in the North American Numbering Plan, the user dials 9, followed by 10 digits. The list of 

codes defined below is simply an example and not intended to be prescriptive. Other dialing 

codes may be appropriate for different customer networks. The Line Group ID is set to 8 

matching the number of the Outgoing Group configured on the Call Details tab of SIP Line 8 

to Bell Canada (Section 5.4.4). 

 

Note that in the Telephone Number field the sip domain “@ISTPdomain.bell.ca” should be 

included as IP office will insert this domain in the Request line and To header for the dynamic 

ONND outgoing call. 
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5.10. Save Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections. 

 

The following will appear, with either Merge or Reboot selected for the Change Mode, based 

on the nature of the configuration changes made since the last save. Note that clicking OK may 

cause a service disruption. Click OK if desired. 
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6. Avaya IP Office Expansion Configuration 
Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign 

next to EXP110 on the left navigation pane will expand the menu on this server. 

 

 

6.1. Expansion System - Physical Hardware 

In the sample configuration, the IP500 V2 Expansion System contained a PHONE8 analog card 

and a DIG DCPx16 V2 card, for the support of analog and digital stations. Also included is a 

VCM64 (Voice Compression Module). The VCM64 card provides voice compression channels 

to the control unit. Voice compression channels are needed to support VoIP calls, including IP 

extensions and or IP trunks. 
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6.2. Expansion System - LAN Settings 

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise 

network. To view or configure the LAN1 IP address, select System on the Navigation pane. 

Select the LAN1 → LAN Settings tab on the Details pane. As shown in Figure 1, the IP 

Address of the Expansion System is 192.168.199.55. Other parameters on this screen may be set 

according to customer requirements 

 

 
 

Defaults were used on the VoIP and Network Topology tabs (not shown). 

6.3. Expansion System - IP Route 

To create an IP route for the Expansion System, right-click on IP Route on the left Navigation 

pane. Select New (not shown). The configuration is similar to the one on the Primary server 

(Section 5.3), with the difference that in the reference configuration, the default gateway for the 

Expansion System is 192.168.199.1. 
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6.4. Expansion System - IP Office Line 

The IP Office Lines are automatically created on each server when the Expansion System is 

added to the solution. Below is the IP Office Line (Line Number 17) to the Primary server. 

 

 
 

In the reference configuration, a fax machine is connected to one of the analog ports on the 

Expansion System. To accommodate T.38 fax, select the VoIP Settings tab and set Fax 

Transport Support to T38 Fallback. The Media Security drop-down menu is set to “Same as 

System (Preferred)” to have IP Office use the system setting for media security set in Section 

5.2.5 to encrypted RTP. 
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Select the T38 Fax tab. The Use Default Values box is unchecked, and the T38 Fax Version is 

set to 0. In the Redundancy area, the Low Speed and High Speed parameters are set to 0. All 

other values are left at default. 

 

 

6.5. Expansion System - Short Codes 

Similar to the configuration of the Primary server in Section 5.6, a Short Code is created to 

access ARS. In the reference configuration, the Line Group ID is set to an ARS route illustrated 

in the next section. 
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6.6. Expansion System - Automatic Route Selection – ARS 

The following screen shows an example ARS configuration for the route named To-Primary on 

the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to 99999 

matching the number of the Outgoing Group ID configured on the IP Office Line 17 to the 

Primary server (Section 6.4). 

 

 

6.7. Save IP Office Expansion System Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections. The following will appear, with either Merge 

or Reboot selected, based on the nature of the configuration changes made since the last save. 

Note that clicking OK may cause a service disruption. Click OK to proceed. 
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7. Bell Canada SIP Trunk Services Configuration 
Bell Canada is responsible for the network configuration of the Bell Canada SIP Trunk service. 

Bell Canada will require that the customer provide the public IP address used to reach the Avaya 

IPO LAN2 public interface. Bell Canada will provide the IP address of the Bell Canada SIP 

Trunk SIP signaling/SBC IP addresses of media sources and Direct Inward Dialed (DID) 

numbers assigned to the enterprise. Bell Canada also provides the Bell Canada SIP Specification 

document for reference. This information is used to complete configurations for Communication 

Manager, Session Manager, and the Avaya SBCE discussed in the previous sections. 

 

The configuration between Bell Canada SIP Trunk and the enterprise is a static IP address 

configuration. 
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8. Verification Steps 
This section provides example verifications of the Avaya configuration with Bell Canada Private 

IP (PIP) Trunk service. 

8.1.  Avaya IP Office 

This section provides verification steps that may be performed with the IP Office. 

8.1.1. System Status Application 

The Avaya IP Office System Status application can be used to verify the service state of the SIP 

line. From the IP Office Manager application, select File → Advanced → System Status.  

Under Control Unit IP Address select the IP address of the IP Office system under verification. 

Log in using the appropriate credentials. 
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Select the SIP line from the left pane (Line 8 in the reference configuration). On the Status tab 

in the right pane, verify that the Current State is Idle for each channel (assuming no active calls 

at present time). In the lower part of the screen, the Trace All button may be pressed to display 

real time tracing information as calls are made using this SIP Line. The Ping button can be used 

to ping the other end of the SIP trunk. 

 

 
 

Select the Alarms tab and verify that no alarms are active on the SIP line. 
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8.1.2. System Monitor 

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling 

messaging on the SIP trunk. Launch the application from Start → Programs → IP Office → 

Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the 

taskbar and Select the IP address of the IP Office system under verification.  
 

 
 

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the 

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the 

color used to represent the packets in the trace can be customized by right clicking on the type of 

packet and selecting to the desired color. 
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9. Conclusion 
IP Office is a highly modular IP telephone system designed to meet the needs of home offices, 

standalone businesses, and networked branch and head offices for small and medium enterprises. 

 

These Application Notes demonstrated how IP Office Release 11.1 can be configured to 

interoperate successfully with a Bell Canada SIP Trunk Services connection to create an end-to-

end SIP Telephony business solution. By following the example configurations provided in this 

document, customers using Avaya IP Office can connect to the PSTN via a Bell Canada SIP 

Trunk Services connection, thus eliminating the costs of analog or digital trunk connections 

previously required to access the PSTN. 

10. Additional References  
This section references documentation relevant to these Application Notes. In general, Avaya 

product documentation is available at http://support.avaya.com. 

 

[1] IP Office, Deploying IP Office Server Edition Solution, Release 11.1, Issue 14, April 2020 

[2] IP Office™ Platform 11.1, Deploying Avaya IP Office Servers as Virtual Machines, April 

2020 

[3] IP Office™ Platform 11.1, Deploying an IP500 V2 IP Office Essential Edition System, April 

2020. 

[4] Administering Avaya IP Office™  Platform with Manager, Release 11.1, Issue 1, April 2020. 

[5] Administering Avaya IP Office™ Platform with Web Manager, Release 11.1, Issue 1, April 

2020. 

[6] Planning for and Administering Avaya IX™ Workplace Client for Android, iOS, Mac and 

Windows, Release 3.8, Issue 1, March 2020 

[7] Using Avaya IX™ Workplace Client for Android, iOS, Mac and Windows, Release 3.8,  

Issue 1, March 2020 

[8] RFC 3261 SIP: Session Initiation Protocol. https://www.ietf.org/rfc/rfc3261.txt 

 

Additional IP Office documentation can be found at: 

https://ipofficekb.avaya.com/ 
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